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Introduction:

This software allows you to create multiple setguéstion paper from a single set by jumbling
the questions in a specified manner.

Questions can be prepared eitherteXCEL ” or as separateVORD” files.

To prepare questions in Excel check sample filesfoies.x|s
To prepare questions in word, check sample filesoe Sample.rtf

A question paper can have multiple sections; eactia can have multiple groups and each
group can have multiple questions.

You can jumble groups within section [12 options{l @uestions within group [12 options] to
create total 144 jumbled options.
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Preparing a New Project

—rw

File +

Mew Project  Ctrl+N
Open Project  Ctrl+O
Save Project  Cirl+5S
Save Project As

[By default software open in “New Project” Mode]
1. Use File=> New Project [Short cut “Ctrl +N”] to start a newopect

-
i&m‘pdu{;ﬁn’g_; Question Jumbling | Layout | Creale Faper |
Groups

Gr.Set | Gr Set | Gr.Set | Gr.Set | Gr Set | Gr. Set Gr.Set | Gr.Set | Gr.Set | Gr. Set
3 4 5 6 7 2] n S

10

=)

2. At the bottom of page [tab: Group Jumbling] speéifyowing:
a. Select Word or Excel
i. You can create questions either in word or in excel
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can be used
To prepare questions in Excel
To prepare questions in word,

equal to this number

If you want to jumble “options”

, select excel othise word or excel both

check sample filesfores.xIs
check sample filesoie Sample.rtf

Number of groups: Questions will be jumbled witk droups only
Total number of questions: The sum total of questim all groups should be

Option Jumbling [Tick]: Whether jumbling of optiomsrequired or not. This

option is suitable only if you are preparing quassi in Excel [see point “a”

above]

Question File Format: Select Format extension testjons. The is required only

if questions are prepared in word or text filesuYoan prepare questions in RTF,

DOC or DOCX format

f. Click “Create New Project”

3. This will create required rows in the table witHfaldt values

Exam Paper Jumbling: UNREGISTERED SOFTWARE
File +

Group Jumbling  Question Jumbling | Layout | Create Paper |

Groups

&7 1.9 “N” shall mean questions will not be

Question Jumbling can be set for each
group.

Gr.
No

No. of
Qin

Ques. Option
Jumbling | Jumbling | 2

] 2 |y

1 2 2 2 v N
: 23
2

[N

Gr. Set | Gr. Set | Gr. Set | Gr, Set | Gr. Set | Gr. Set | Gr.
3 4 5 6 7

Project is created with default values.

By default only one section [1] is created, you
can increase number of sections and Section
Group Number, for example for 2 sections, 1
Group in first section while 3 groups in section
you can write:

jumbled in that group.

Similarly, options jumbling can also be se¢t
for each group.

Project is created with default values.

Change Number of questions in each
group to be equal to total number of
guestions.

| Werify Project |

Click “Verify Project” after editing project

Section Sec Gr No AN
1 1 Create New Project ] | v/ \qqg |
L 2 1
2 2 X .
° 3 requirements.

This is similalr to how groups and questions
are numbered in “Question Jumbling” tab.

It will verify project requirements as well
as create question numbering and other
parameters.
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Exam Paper Jumbling: UNREGISTERED SOFTWARE

File =

Group Jumbling || Guestion Jumbling Layout | Create Paper

Exam Paper; Set Question Jumbling

=1 oE =)

[ seoponmoing | 2 N | I T T |
Seq. Q. No. Grle | G, Ir_fynm.r‘ﬂle g Set g! Set (4] Set (5} Set g Set (. Set |QSet |QSet [0.Set |Q.Set Q. Set
1 1 |Qldosx
Q.2 1 2 |Q2docx =
a3 1 3 |Q3doex « . . " . .
a.s 1T | 4 |akden In “Question Jumbling” tab, list of questions
Q.5 1 5 |Q@5.docx i
- s will get created.
.IQ 7 1 | 7 ;GTdm:x
2 S In questions will be prepared asdrd” files,
.10 (IR CICEE File Names will be listed here. You can changg if
an 1 11 Q17 doex
Q.12 71 [ 12 |o12deex you want.
Q.13 1 13 [Q13docx
Q.14 1 14 | Q14.docx
.Q 15 1 | 15
a.18 1 | 16 |Gi6des
Q.17 1 17 |Q17docx
Q.18 1 18 |@18doox Gr NO and Q NO-
.Q 15 1 15 iGTBdum ' : ' ’ . . .
an 1| 2 [cldee By default all groups will be crated with required
a2 N v questions. To change you need to change project
lo 23 1| 22 losien requirements in “Group Jumbling” Tab.
If questions are in EXCEL, wite A, B or None in "Layout/File Name" column
If questions are in WORD, write file name with extension like Q1 .1if in "Layout/File Name" column

Exam Paper Jumbling: UNREGISTERED SOFTWARE

File ~

Group Jumbling || Guestion Jumbling  Layout | Create Paper

Exam Paper: Set Guestion Jumbling

| Set Option Jumbling i

[E=S|EcE x|

——— Gt | Qo | Lo QS Q5% OS54 OS 05¢ QS 05 Q5 QS 05 Q5
la.2 12 a 3
Q3 1|3 |a

Q.4 1| 4 |a

las 1| 5 |a

o 1| 6 |A

Q.7 1|7 |a

a8 T8 [A }

as 9 |a will get created.

Q.10 R

an R

a1z 7 2 [a

ERE IENEE

214 EED

[S:do 1|15 s “B” or “None”.

Q.16 T ETHI

Q.17 1|17 |a

la1s 1 A

Q13 R

|a.20 1 0 A

Q.21 1 |2 |a

a2 1 [ 2 [a

Q2 1 1z | =

In “Question Jumbling” tab, list of questions

In questions will be prepared ikXcel file,
Layout will be listed here. Layout can be “A”,

For “None” as layout, options will not be printed.

If questions are in EXCEL, write A, B or None in "Layout/File Name" column.
If questions are in WORD, write file name with extension like Q1 1f in "Layout /File Name™ column

Save Question Jumbling | I Werify Question Jumbling
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4. Prepare a proper database as described below:
a. Group Heading will be as below:

Section Number: numeric

Group Number: numeric [restart from 1 in each secton]
Group Serial Number: numeric [sequential from 1 onvards]
Number of Questions: numeric [in the group]

Question Jumbling: Y or N [capital]

Option Jumbling: Y or N [capital]

b. Questions Headings shall as below:

Question Serial Number: numeric [sequential from Q.1 onwards]

Group Serial Number: numeric [should correlate with groups defined above]
Question Number: numeric [restart from 1 in each setion]

Layout/File Name: See below

If you are creating Questions in EXCEL, you canirefayout as A, B or None
If you are creating questions in WORD, you shoirttktfile name with extension like
Q1.rtf [you can use rtf, doc or docx format]

5. Click “Save Project As” and select the location apdcify file name
“ExamConfig.csv.

6. You can save in other name also for creating backiges but to open a project in the
system file name should be “ExanConfig.csv”
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Verifying a Project

1. Once you have created a project it is advisabletiby project

2. Click “Verify Project” on “Group Jumbling” tab. Thiwill verify main project
parameters such as numbers of groups, number sfigue etc.

3. You should also verify parameters manually bec#uisgs like wrong file names etc
will not be verified by the system. Make sure tyat list all questions. This is how
master set will be printed; jumbled or other setshave their own question numbers.

4. Group Jumbling and Question Jumbling will work only if basic project parameters
are correct.
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Preparing Questions and other files

1. To prepare questions in Excel check sampleQiestions.xls

2. To prepare questions in word, check sampleQuestion_Sample.rtf.By default
system suggests question names as Q1, Q2, Q3thtdesired extension though you
can give any desired name. Change the name asamin/Layout/File Name”
column as described above.

3. In addition to questions files, you need to prepeader, footer and group header
files as below:

a. FirstPage.rtf
This is the first page of the question paper.

b. LastPage.rtf
This is last page of the question paper

c. GroupN.rtf
You need to prepare header files for all the gro&ps example if you have
four groups in the question paper you need to peeaoupl.rtf, Group?2.rtf,
Group3.rtf and Group4.rtf
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Creating Jumbled Groups set

Use G2, G3, ...(Short cut “Alt+27, “Alt+3”, etc) ks to create GROUP jumbling. You can
generate 12 group jumbling [including one default].

You can also edit manually. Click “Verify Group Joimg” on “Group Jumbling” tab to
verify there is no repeat groups of missing growpsn group jumbling is created or edited
manually.

|]_'_ Question Jumbing | Layout | Create Paper |
‘[_][_] (o) () () (o) () () (o) () (e

Gr Set | Gr Set | GrSet | GrSet |GrSe | Gr Set Gr Set | Gr Set | Gt Gr.Set | Gr. Set
2 3 4 5 6 |7 5 1 5 12
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Creating Jumbled Questions Set and Options Set

Use F2, F3, F4, ...(Function keys) to generate JathQuestion sets. You can generate total
12 question jumbling [including one default].

You can also edit manually. Click “Verify Questidambling” on “Question Jumbling” tab
to verify there is no repeat question or missing(ion when question jumbling is created or

edited manually.

Exam Paper Jumbling: UNREGISTERED SOFTWARE = Eos
File -
Group Jumbling ’m La)'DLﬂi Create Paper

Exam Paper: Set Question Jumbling

[ SetOpugn umbing | (e )lm ][r]lmlm]|lm]lr]lr][mn][m]lH]

~—

e Q5 |QSe |QSe QS Q5 Q5o Q54 QS Qs Qs Qs =
N | - : ' ' 2 |z |w o & s

la.2 12 |a E 7 ¢ 7 [+ |3 E
a3 T3 |a s b o [+ |5 |m |2

o 1| 4 |a [0 |5 ' o | PR

5.6 1| 8 & 5 s | Use this button to change [toggle] between

e h - 7| creating “Question Jumbling” and “Options

lae 18 |a s 2 | Jumbling”

las [1 ]9 |a 6 [

|a.10 [7 w0 [a FE 2 T o |4 3 3 3 3 10

a1 [z |1 |a R REE e 7 & [3 [« s

la.12 [ 2 ]2 |a 3 6 & J& Jo Ja [w |wo 7

la.13 [2 [ 3 |a R N N R R e E wo |z |4

@ 14 [2 ] 2 [a f & [« 7 J& 2 Ja [z |2 2 |7

|a.1s [2 |5 [a 7 & [=2 |8 |2 8 [8 |z |5 |

|a.1s [2 [ s |a 7 o |+ |2 &+ | J&¢ 1o & |uo s

la.17 [2 |7 |a e & o 5 Jo | |2 J¢+ J& J& |2

a1 [2 [ & [a [ 5 5 [¢ J2 [¢6 [ [3 |5 [t |o

Q.19 2 | 3 |a 5 T3 s 3 3 1 2 8 3 8

|a.20 [ 2 [ 10 |a [ e |0 3 1[5 |5 [5 |7 |8 [z s

.21 ERERD [ |7 5 |2 |i© |12 |3 |3 |3 |m |0

a2 [3 ]2 [a 21 |a 2 |15 |3 8 | s 7 |= |

la 23 3 "3 [a FREY 6 119 |5 |1 5 5 17 =

If questions are in EXCEL, write A, B or None in "Layout/File Name" column.
I questions are in WORD, write file name with extension like Q1.nf in "Layout/File Name" column.

Save Question Jumbling [ Verify Question Jumbling |

T
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Exam Paper Jumbling: UNREGISTERED SOFTWARE == EoE |

File -~

Group Jumbling || Question Jumbling Layout | Create Paper

Exam Paper; Set Option Jumbling

[ SetQuegtondumbing | > /| 2z [ r2 ][ ra |[m ][ /e J[rz ][ re][r |[ro|[m][r]

o~

Seq. Q. No, Layout /File Cs)ption 'Option 'Option 'Option Option | Option 'Option 'Option Option 'Option 'Option 5
2 |Set3 |Setd |Sa5 | Set6 |Set7 |Set® |Get9 | Set0 | Setii | Set12

N 0 | - F 2z | 2 | v 2 |5 N '

- et ] | z | | i e X

a3 1] 3 |a E [1 P [2

o4 1] 4 |a 1 [3 R R [

95 t 8@ ' | Use this button to change [toggle] between

o 1| & |a 2 2 . . L w .

= 5 1= , ;| creating “Question Jumbling” and “Options

X 1] 8 |a 1 2 | Jumbling”

la.s 1] 8 |a 1 [1

a0 [ 1 | 10 |a 2 |4 1 T4 4 4 1 1 3 3 1

la.n [z |1 |a o o o o lo [0 o o o [0 o

la.12 2 | 2 |a 0 0 0 b o 0 0 0 0 0 0

la.13 [ 2 | 3 |a o o o Jo e Jo Jo [0 [0 Jo

.14 [ 2 | 4 [a o o [0 o o Jo o Jo [0 o o

la.15 [ 2 | 5 [a o o Je o Jo Jo o Jo o |0 o

PR [ 2 | & |a o o Jo o o Jo o Jo o |0 o

la.17 [2 |7 |a o o Je e Jo Je o Jo o |0 o

FRE [ 2 | & [& e o |0 o o Jo o Jo |0 o o

|19 [ 2 | 9 [a e o Je o Jo Jo o Jo o |0 o

|a.20 [z | 10 |a o o Jo o o Jo o [ o [0 o

la.21 [ 3 | 1 |a 2 [2 1 [2 4 [2 [4 4 [a [1 [2

a2 [3 | 2 [a 2 |2 & |2 £ |3 i "RE [« |4

lo22 [ 3 1 3 Ia R I T I P PR I R I b

If questions are in EXCEL, wrte A, B or None in "Layout/File Name" column.
If questions are in WORD, wiite file name with extension like G1.if in "Layout/File Name" column.

| Save Question Jumbling | Verify Question Jumbling |

Click “Set Option Jumbling” to create jumbling foptions. Use F2, F3, F4, ...(Fb-J;ion keys) to
generate jumbled options sets.

Options Jumbling Values could be 1 to 4 [0 meanspt®mn jumbling]. You can also edit
manually. Click “Verify Question Jumbling” on “Quisn Jumbling” tab to verify there is no
value higher than 4. Any value higher than 4 well mmbling to default.

Option Jumbling will be done as follows:
1: A>B, B>A,C->D,D>C
2: A>C,B>D, C>A, D>B
3: A>D,B>A,C->B,D>C

4: A>D, B>C, C>B, D>A
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Saving a Project

Click “Save Project” or “Save Project As”.

If you have opened an existing project it will salee file save dialog box will open.
Select the location and specify file nantexamConfig.csv.

You can save in other name also for creating backipges but to open a project in the
system file name should be “ExanConfig.csv”

File ~r|

Mew Project  Cirl+N

PN

Cpen Project  Ctrl+0
Save Project  Ctrl+5
Save Project As

Help F1 lof
About ... Alt+ A
Close Alt+C

“Save project as can be used to create backupndasiother projects.
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Opening an Existing Project

File > Open Project [Short cut “Ctrl +O”]. Select “Projdale [ExamConfig.csv]” and click
open.

File v|
Mew Project  Ctrl+N
Open Project  Ctrl+0

Save Project  Cirl+5

Save Project As 3
Help F1 fof
About ... Alt+A
Close Alt+C
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Setting Layout

On the “Layout” tab you can set:
1. Format and font for question number.
2. Layout dimensions and alignment
3. During creation of paper [if you are using EXCElojexct], you can select two
column printing for multi language project [two tarages on same paper in two
columns. For those projects select change settint$&s Column Defaults”.

Exam Paper Jumbling: UNREGISTERED SOFTWARE =

File =
Group Jumbling I Question Jumbling I Layout Create Paper
Format and Font for Question Numbers
|O. 1 } Fort | 1 Eolumn Defaults | | 2 Column Defaults
Set Below only when Questions are in Excel:
Layout [A] Table width in mm 170 Layout [B]
Q. No. Guestion Q. No
A Option_A c Option_C A [ Dption_A \
A IC. B | Option_B ‘
& Option_C
BB Option_B [I):,‘I Ciption_D | P ‘
’ ) D | Option_D ‘
Set Width in mm Set Width in mm
|1D ]10 |?u ]m ]10 |150
Text Alignment
1 Gap between Column intwo column layout
Q. No. Guestion Text Honizortzl
Left - 10
Vertical
Top -
ABCD Option_A_B_C_D
Harizontal Horizontal Horizontal
Left - Left - Left -
Vertical Vertical Vertical
Top - Top - Top -

Format and Font for Question Number:

You may like to write question number as one olbfwing or more ways:

1. Q.1

2. Q.1

3. Q. (1)

4. [Q.1]

5. More .....
You can set any character in the specified plabe.fént should match the font type and size
of the font of the question used in questions.
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Creating Papers

1.

2.

Click “Create Paper” tab.
Select Jumbled Group set and Jumbled question set.

a. Gl is default non-jumbled groups
b. F1 is default non-jumbled questions. For “F1” opsawill not be jumbled even if
specified for the groups.

Click “Create Paper”. Exam paper will be createWMford” and saved. File Name will
be displayed on screen.

For Multi Language papers create questions sirtoléirst language [either word files or
excel file] and save the files in a FOLDER [Diragfanside project folder directory.
Select “Two Language” check box and specify theaory name.

You can also select two column layout to print giees in two languages side by side.
[This can be done only in excel projects.

File =
| Group dumbing | Question Jumbling | Layott |[Create Paper

Select Jumbled Group Set [ G is non{umbled Group |
) ; ) ) [] Two Languages [T Two Column Layout (For EXCEL)
@G OG22 06 OGd ©G G ©GT O G @G @G0 @GN @GR

Select Jumbled Question Set [ F1is nonjumbled Question / non{umbled options |
R @R @B O @©Ff EF OF ©B OB OF0 @ © F2

Questions Jumbling Grid
Q. No. | Gr.No | @.No. | Paper_1_1 Paper_1.2 Paper_1_3
h 1 1 a1 Q.10 Q.10
Q.2 1 2 |a.z2 Q.2 Q.7
Q.3 1 3 0.3 a.6 Q.8
Q.4 1 4 |04 Q.1 Q.1
Q.5 1 5 (a5 Q.5 Q.4
Q.6 1 6 |a.6 Q.9 a5
Q.7 1 7 Q.7 Q.3 a.6
Q.8 1 3 (0.8 Q.7 Q.2
Q.9 1 9 |0.9 Q.8 Q.3
Q.1 1| 10 |a.0 Q.4 Q.9
Q.11 2 1oan Q.20 Q.19
Q.12 2 | 2 |a2 a1 Q.13
Q.13 2 | 3 a3 Q.12 a1
Q.14 2 | 4 | Q.14 Q.17
Q.15 2 | 5 lats Q.19 Q.18
Q.16 2 | 6 |a6 Q.17 Q.12
Q.17 2 | 7 a7 Q.16 Q.15
Q.18 2 | 8 |a8 Q.15 Q.14
Q.19 2 | 8 las Q.13 Q.16
2 in (. 11 O 19 020
| ©@ Direct Listing with respec: to Oniginal G1F1 ) Where Moved With Respect 2 Original G1F1 I Creste Jumble Grid I l Save Jumble Grid
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Creating Jumbling Report

1. Click “Create Paper” tab.
2. Select Jumbled Group set and Jumbled question set.

a. Gl is default non-jumbled groups
b. F1 is default non-jumbled questions. For “F1” opsawill not be jumbled
even if specified for the groups.

3. You can create jumbling report in two ways
a. Sequence of questions with respect to originalsest image on previous
page]
b. Where the question is moved in the respective gatr@spect to the original
set [see image below]
4. Click “Create Jumble Grid”. The sequence of questidl be shown in the grid.
5. Click “Save Jumble Grid” to save the grid in cde fivhich can be opened using
EXCEL.
Note: Add only one type of sequencing in grid faviag to avoid confusion.

File =
Group Jumbling | Question Jumbiing | Layout || Create Paper

Select Jumbled Group Set [ G1is nonjumbled Group ]

@GOG O6I Oad D6 G668 OG7 OG6E O6Y © G600 6T E G2

[] Two Languages  [] Two Column Layout {For EXCEL}

Secong Language Directory  Demo
Select Jumbled Question Set [ F1is nonjumbled Question / non-umbled options |
OF o @B O OF OF GF B 6P G M ©F2

Questions Jumbling Grid
| Seq. Q. No Gr.No | Q.No. | Paper 11 Paper 1.2 Prpe 1.3
1 1 Q1 Q.4 Q.4
Q.2 1 2 |a.2 Q.2 Q.8
Q.3 1 3 |Q3 Q7 Q.9
Q.4 1 4 0.4 Q.10 Q.5
Q.5 1 5 |Q:5 Qb Q.6
Q.6 1 & |Q.6 Q.3 Q.7
Q.7 1 7.7 Q.8 Q.2
Q.8 1 8 |Q.8 Q.9 Q.3
Q.9 1 5 |Q.9 Q6 Q.10
Q.10 1 0 |G.10 a1 a1
an 2 1 jan Q.12 Q.13
Q.12 2 2 Q.12 Q.13 Q.16
Q.13 2 3 |@.13 Q.18 Q.12
Q.14 2 4 1G4 Q.14 Q.18
Q.15 2 5 |Q.15 Q.18 Q.17
Q.16 2 6 Q.16 Q.17 Q.19
Q.17 2 7|Q.17 Q.16 Q.14
Q.18 2 8§ |Q.18 Q.20 3.15
Q.19 2 3 |Q.19 Q.15 Q.1
0 2 A0 a1 011 0 Y
) Diect Listing withrespectto Ongnal GIF1 ®) Wihers Moved Wit Respect 20rgral G171 | CetedumbleGrd | | Save umble Grg
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Important Random Notes

1. When creating questions in EXCEL and using imageske sure that you adjust the size
of the cell by inserting new lines and adding saima&racters in each line and making
them “white”. This will ensure that the questiosgrinted properly in the exported word
file. See sample Questions.xls file give with ifista You can find samples in “samples”
directory in installation folder.

2. For creating same sets in multiple languages cé&xafhConfig.csv” in the folder
containing other language questions and other. files

3. You can click “Change Grid View” to toggle betweBaquential question number and
group serial number wise reporting in “question fplimg” tab. This will show only for
default group sequence.

4. Save jumbling configuration in separate csv filsgg “Save Question Jumbling
button. Your will be asked to enter some identtima detail and file name.

5. Once Exam paper configuration is final, you caresawject using “File> Save
project” menu. Give File name and save at deswedtion. The file will have [.csv]
extension.

6. Click “Help” (Shortcut key “F1”) to open this help.

7. Click “About ...” (Shortcut key Alt + A”) to know about this product, copyright, etc.

8. Click “Closé’ (Shortcut key Alt + C”) to close this application.
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Setting on Network

For networks a separate program is released witiwdtk License dongle is released.
To work on network you need to run CI32srv.exelmnderver and define required parameters.
You can do the same when using windows workgroup.

You will find link to CI32serv.exe in program filesd on desktop after installation. You can run
the file directly from “Application Installation Fder/Network/Cl32serv.exe”.
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